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AUTHOR’S NOTE PAGE (COPYRIGHT) 

 

The competent development body of this manual is Rwanda TVET Board © reproduced with 

permission. 

All rights reserved. 

▪ This work was produced by the Rwanda TVET Board, with the support from the 

European Union (EU). 

▪ This work has copyright but permission is given to all the Administrative and Academic 

Staff of the RTB and TVET Schools to make copies by photocopying or other duplicating 

processes for use at their workplaces.  

▪ This permission does not extend to making copies for use outside the immediate 

environment for which they are made, nor making copies for hire or resale to third 

parties.  

▪ The views expressed in this version of the work do not necessarily represent the views 

of RTB. The competent body does not give a warranty nor accept any liability.  

▪ RTB owns the copyright to the trainee and trainer’s manuals. The training providers 

may reproduce these training manuals in part or in full for training purposes only. 

Acknowledgment of RTB copyright must be included in any reproductions. Any other 

use of the manuals must be referred to the RTB.  

© Rwanda TVET Board 

Copies available from: 

o HQs: Rwanda TVET Board-RTB 

o Web: www.rtb.gov.rw 
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Original published version: April 2025. 
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INTRODUCTION 

 

This Trainer’s Manual encompasses all methodologies necessary to guide you to properly 

deliver the module titled: “CCMIW502– Information and Communication Technology (ICT)”. 

Students undertaking this module shall be exposed with practical activities that will develop 

and nurture their competences. The writing process of this training manual embraced 

competency-based education and training (CBET) philosophy by providing practical 

opportunities reflecting real life situations. 

The Trainer’s Manual is subdivided into Learning Outcomes, each learning outcome has got 

various topics. You will start guiding a self-assessment exercise to help students rate 

themselves on their level of skills, knowledge and attitudes about the unit. 

The Trainer’s Manual will give you the information about the objectives, learning hours, 

didactic materials, proposed methodologies and crosscutting issues. 

A discovery activity is followed to help students discover what they already know about the 

unit. 

This manual will give you tips, methodologies and techniques about how to facilitate students 

to undertake different activities as proposed in their Trainee’s Manuals. The activities in this 

training manual are prepared such that they give opportunities to students to work 

individually and in groups. 

After going through all activities, you shall help students to undertake progressive 

assessments known as formative and finally facilitate them to do their self-reflection to 

identify your strengths, weaknesses and areas for improvements.  

Remind them to read the point to remember section which provides the overall key points 

and takeaways of the unit. 
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Information and Communication Technology (ICT) 

Learning Outcomes Learning Hours Topics 

1. Prepare document Layout 10 1.1 Setup a document layout 

1.2 Insert and manage images in 

a document 

1.3 Create and manage 

references in a document 

2. Apply basic computer 

operations 

10 2.1 Convert files into different 

formats 

2.2 Use of storage media 

2.3 Connection of computer to 

the network 

3. Manage data in MS Excel 10 3.1 Management of data types in 

MS Excel 

3.2 Application of Excel functions 

3.3 Perform data analysis and 

visualization in excel 

3.4. Application of data protection 

techniques in excel 
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LEARNING OUTCOME 1: PREPARE DOCUMENT LAYOUT 
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Learning outcome 1: Self-Assessment 

1. Ask trainees to look at the unit illustration in their Trainee’s Manuals and together discuss: 

a. What does the illustration show?  

b. What topics do you think will be covered under this unit based on the illustration? 

2. After the discussion, inform students that this unit is intended to provide them with the 

knowledge, skills and attitudes required to prepare document layout, tell them that they 

will cover setting up a document layout, inserting and managing images in a document, 

creating and managing references in a document. 

3. Ask trainees to fill out the self-assessment at the beginning of the unit in their Trainee’s 

Manuals. Explain that: 

a. The purpose of the self-assessment is to become familiar with the topics in the unit 

and for them to see what they know or do not know at the beginning.  

b. There are no right or wrong ways to answer this assessment. It is for their own 

reference and self-reflection on the knowledge, skills and attitudes acquisition during 

the learning process.  

c. They should think about themselves: do they think they have the knowledge, skills or 

attitudes to do this? How well?  

d. They should read the statements across the top and put a check in column that best 

represents their level of knowledge, skills or attitudes.  

e. At the end of the unit, they will do a self-reflection, which includes re-taking the self-

assessment and identifying their strengths, areas of improvement and actions to be 

taken. 
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Key Competencies: 

Knowledge Skills Attitudes 

1. Describe page layout 

components 

1. Adjust page layout  1. Pay attention to layout 

details. 

2. Describe page 

background 

components 

2. Apply page 

background 

2. Maintain consistency in 

formatting styles. 

3. Describe text 

formatting components  

3. Apply advanced 

text formatting  

3. Develop innovative ideas 

for designs 

4. Identify steps for 

inserting pictures 

4. Insert pictures 4. Be precise when applying 

tools 

5. Identify steps for 

editing pictures 

5. Edit picture  

6. Identify steps for 

creating table of 

contents 

6. Create table of 

contents 

 

7. Define captions 7. Add captions  

8. Identify steps for adding 

citations and 

bibliography 

8. Add citations and 

bibliography. 
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 Steps:  

Discovery Activity 

Task 1 

1. Employ suitable methods such as individual work, pair-share, small group discussions, 

guided discussions, or large group discussions to facilitate trainees in sharing their 

understanding and prior knowledge of the concept "preparing document layout." 

Ensure that instructions are clear, all trainees are actively participating, and necessary 

materials or tools are provided and utilized effectively. 

2. Direct the trainees to Task 1 in their manual to answer the questions provided. 

3. Using an appropriate methodology such as question and answer in a large group, pair 

presentations or small group presentations, trainees share their answers to the class. 

4. Encourage all trainees to share their views and findings. 

5. After the presentations or sharing session, explain to the trainees that the purpose of 

this activity was not to provide correct answers but to give them an overview of what 

will be covered in the unit. 

6. Introduce Topic 1.1: Setup a document layout   
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Topic 1.1: Set up a document layout 

  

Objectives:  

By the end of this topic, trainees will be able to: 

a. Customize properly page dimensions and margins to enhance document 

readability and presentation. 

b. Apply properly background styles and colors to improve visual appeal and 

branding. 

c. Implement properly advanced formatting techniques to ensure 

professional and structured document layouts. 

 
Time Required: 4 hours 

 
Learning Methodology: Group Discussion, Trainer Guided, Videos, 

Brainstorming, Demonstration, Practical Exercises, Individual Work 

 

Materials, Tools and Equipment Needed: 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

Preparation:  

❑ Prepare all necessary materials and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 
Prerequisites: 

ü Prior skills in computer literacy 
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 Activity 1: Problem-Solving 

Task 2 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to help trainees analyze the 

scenario and respond to the questions in Task 2 of their trainee manual. Ensure that the 

instructions are clear, all trainees are engaged, and the necessary materials or tools are 

available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 

3. After the sharing session, refer trainees to Key facts 1.1, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

Activity 2: Guided Practice 

Task 3 

1. Use a suitable approach, such as individual work, pair-share, small group discussions, 

guided discussions, or group discussions, to assist trainees to perform Task 3 in their 

trainee manuals. Ensure that instructions are clear, all trainees are actively engaged, 

and the required materials or tools are available and utilized effectively. 

2. During the task, trainees should have some independence to apply the knowledge and 

skills learned in Activity 1. Your role is to guide them by asking probing questions like 

"Why?", "What?", and "How?" to help them arrive at well-informed answers. 

 



 

9 | INFORMATION AND COMMUNICATION TECHNOLOGY (ICT) – TRAINER’S MANUAL 
 

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 

among others. Also attitudes and behavior changes should be handled during this 

activity. 

4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 1.1, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

Activity 3: Application 

Task 4 

1. Inform the trainees that Task 4 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 4. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and create an invitation card in MS word in order to 

demonstrate how to setup a document layout. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 4 with the class. 

5. The sharing or presentation session will commence once all trainees have been 

assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to 

apply the knowledge, skills and attitudes acquired to real life situations. Your role is to 

set clear instructions, methodology and timeframe for performing the task and 

presentations. 
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7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment Criteria Indicator Observation 

Yes No  

1. Page Setup 1.1 A5 page size is selected 
 

  

1.2 1-inch margins are applied 
 

  

1.3 Portrait orientation is set 
 

  

2. Layout and 

formatting 

2.1 Content is organized into columns  
 

  

2.2 Section breaks are applied    

2.3 Hyphenation is enabled  
 

  

2.4 Indentation is adjusted  
 

  

2.5 Paragraphs are adjusted    

2.6 Line spacing (1.5) is respected    

3. Page 

background 

3.1 A personalized watermark is added 
 

  

3.2 Light blue accent color is applied 
 

  

3.3 An art decorative border is included 
 

  

4. Text styling and 

emphasis 

4.1 Bold, Arial font is used throughout the 

text 

 
  

4.2 Text effects are applied  
 

  

4.3 Shading is applied to highlight important 

details 

 
  

5. Professionalism 

and aesthetic 

appeal 

5.1 The design is visually appealing  
 

  

5.2 The invitation maintains clarity  
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Topic 1.2: Insert and manage images in a document 

 

 Objectives:  

By the end of the topic, trainees will be able to: 

a. Insert a picture properly within a document  

b. Apply picture styles properly to format images visual designs 

c. Arrange picture properly to create a professional document. 

 
 Time Required: 2 hours  

 

 Learning Methodology:  

• Learning Methodology: Group Discussion, Trainer Guided, Videos, 

Brainstorming, Demonstration, Practical Exercises, Individual Work 

 

 Materials, Tools and Equipment Needed: 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

 Preparation:  

❑ Prepare all necessary materials and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

 Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 

 Prerequisites: 

Ø Prior skills in computer literacy 
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Activity 1: Problem-Solving 

Task 5 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to help trainees analyze the 

scenario and respond to the questions in Task 5 of their trainee manual. Ensure that the 

instructions are clear, all trainees are engaged, and the necessary materials or tools are 

available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 

3. After the sharing session, refer trainees to Key facts 1.2, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

Activity 2: Guided Practice 

Task 6 

1. Use a suitable approach, such as individual work, pair-share, small group discussions, 

guided discussions, or group discussions, to assist trainees to perform Task 6 in their 

trainee manuals. Ensure that instructions are clear, all trainees are actively engaged, 

and the required materials or tools are available and utilized effectively. 

2. During the task, trainees should have some independence to apply the knowledge and 

skills learned in Activity 1. Your role is to guide them by asking probing questions like 

"Why?", "What?", and "How?" to help them arrive at well-informed answers. 

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 
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among others. Also attitudes and behavior changes should be handled during this 

activity. 

4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 1.2, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

 Activity 3: Application 

Task 7 

1. Inform the trainees that Task 7 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 7. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and create an poster card in MS word in order to 

demonstrate how to work with pictures within a document. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 7 with the class. 

5. The sharing or presentation session will commence once all trainees have been 

assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to 

apply the knowledge, skills and attitudes acquired to real life situations. Your role is to 

set clear instructions, methodology and timeframe for performing the task and 

presentations. 

  



 

14 | INFORMATION AND COMMUNICATION TECHNOLOGY (ICT) – TRAINER’S MANUAL 
 

7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment 

Criteria 

Indicator Observation 

Yes No  

1. Insert picture 1.1 Change size of a picture is done    

1.2 Compress a picture is done    

1.3 Increase the Contrast is done    

2. Picture styles 2.1 Picture border is sated    

2.2 Picture effects is done    

2.3 Picture layout is sated    

3. Arrange picture  

 

3.1 Position of picture is changed    

3.2 Wrap text around a picture     

3.3 Rotate a picture    
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Topic 1.3: Create and manage references in a document 

 

Objectives:  

By the end of the topic, trainees will be able to: 

a. Create a document properly formatted in-text citations and a bibliography 

using the referencing tools in Microsoft Word. 

b.  Demonstrate the ability to use built-in styles for references, such as APA or 

MLA, and modify at least one citation format to meet specific guidelines. 

c. Generate a table of contents, list of figures, and bibliography for a sample 

document, ensuring all references are properly linked and updated 

automatically. 

 
Time Required 4 hours. 

 

Learning Methodology:  

• Learning Methodology: Group Discussion, Trainer Guided, Videos, 

Brainstorming, Demonstration, Practical Exercises, Individual Work 

 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

Preparation:  

❑ Avail all necessary materials to the topic such as books and internet 

❑ Prepare computer laboratories 

' 

Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 

Prerequisites: 

Ø Prior skills in computer literacy 
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Activity 1: Problem-Solving 

Task 8 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to help trainees analyze the 

scenario and respond to the questions in Task 8 of their trainee manual. Ensure that the 

instructions are clear, all trainees are engaged, and the necessary materials or tools are 

available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 

3. After the sharing session, refer trainees to Key facts 1.3, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

Activity 2: Guided Practice 

Task 9 

1. Use a suitable approach, such as individual work, pair-share, small group discussions, 

guided discussions, or group discussions, to assist trainees to perform Task 3 in their 

trainee manuals. Ensure that instructions are clear, all trainees are actively engaged, 

and the required materials or tools are available and utilized effectively. 

2. During the task, trainees should have some independence to apply the knowledge and 

skills learned in Activity 1. Your role is to guide them by asking probing questions like 

"Why?", "What?", and "How?" to help them arrive at well-informed answers. 

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 
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among others. Also attitudes and behavior changes should be handled during this 

activity. 

4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 1.3, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

Activity 3: Application 

Task 10 

1. Inform the trainees that Task 10 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 10. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and prepare an industrial attachment report in MS word 

in order to demonstrate how to add references in a document. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 10 with the class. 

5. The sharing or presentation session will commence once all trainees have been 

assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to 

apply the knowledge, skills and attitudes acquired to real life situations. Your role is to 

set clear instructions, methodology and timeframe for performing the task and 

presentations. 
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7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment 

Criteria 

Indicator Observation 

Yes No  

1. Table of 

contents 

1.1. Heading styles are applied    

1.2. Sections and subsections are sated    

1.3. Table of content is created    

2. Footnotes 2.1. Footnotes are applied on the page    

3. Citations 

and 

bibliography  

 

3.1. Style is applied    

3.2. New source is added     

3.3. References are displayed at end of a 

document 

   

 

 Formative Assessment  

Multiple-Choice Questions (MCQs) 

1. Which feature is used to adjust the space between lines of text in a paragraph? 

a. Paragraph Indentation 

b. Line Spacing 

c. Page Margins 

d. Font Effects 

Answer: b) Line Spacing 

2. What is the default paper orientation in Microsoft Word? 

a. Landscape 

b. Portrait 

c. Square 

d. Custom 

Answer: b) Portrait 

3. How can you add captions to a picture in Microsoft Word? 

a. Using the "Insert Caption" option under the References tab 

b. By clicking on "Wrap Text" 

c. Under the Page Layout tab 
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d. Using the Picture Styles menu 

Answer: a) Using the "Insert Caption" option under the References tab 

4. What is the purpose of compressing a picture in Word? 

a. To change its color 

b. To reduce file size 

c. To add effects 

d. To crop the image 

Answer: b) To reduce file size 

5. Which tab contains the option to add page borders? 

a. Home 

b. Page Layout 

c. References 

d. Insert 

Answer: b) Page Layout 

True or False Questions 

6. True/False 

a. Section breaks allow different formatting options within the same document. 

(True/False) 

Answer: True 

b. Watermarks cannot be customized in Microsoft Word. (True/False) 

Answer: False 

c. Indenting a paragraph alters the line spacing of the entire document. (True/False) 

Answer: False 

7. Fill in the Blanks 

a. The feature used to change the position of a picture is called __________. 

Answer: The feature used to change the position of a picture is called Wrap Text. 

b. Page borders are found under the __________ tab in Word. 

Answer: Page borders are found under the Design tab in Word. 

c. Compressing a picture reduces its __________ size while maintaining visual 

quality. 

Answer: Compressing a picture reduces its file size while maintaining visual 

quality. 
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Open Questions 

8. Explain the significance of page margins, paper orientation, and page size in creating 

professional documents. 

Page margins define the space between the content and the edges of the paper, ensuring 

readability and aesthetics. Paper orientation (portrait or landscape) determines how 

content is aligned and presented. Page size (e.g., A4, Letter) ensures the document fits 

the intended output medium, maintaining professionalism and consistency. 

9. How do you add a watermark to a document? Provide examples of when watermarks 

are used. 

To add a watermark: 

a. Go to the Design tab. 

b. Click Watermark and choose a pre-designed option or customize it. 

c. Use the Custom Watermark option to insert text or an image. 

Watermarks are used for purposes such as marking a document as confidential, adding 

branding, or indicating drafts. For example, “Confidential” or “Draft” watermarks are 

common. 

10. Compare and contrast "Indenting a paragraph" and "Paragraph and line spacing" in 

document formatting. 

a. Indenting a Paragraph: Refers to adjusting the starting point of a paragraph from the 

left or right margin. Used for block quotes or distinguishing sections. 

b. Paragraph and Line Spacing: Refers to the vertical space between lines of text or 

paragraphs. It affects document readability and structure. 

Both improve document organization but serve different purposes. 

11. Explain how to apply font effects and shading to text for emphasis. 

a. Font Effects: Highlight text and go to the Font group in the Home tab. Apply bold, 

italic, underline, strikethrough, or superscript/subscript for emphasis. 

b. Shading: Select text, go to the Paragraph group, and click Shading to add a 

background color. 

These enhance text visibility and draw attention. 

12. What are the steps to compress a picture in Word? Why is this feature important? 

Steps: 

1. Select the picture. 
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2. Go to the Picture Format tab. 

3. Click Compress Pictures. 

4. Choose compression options (e.g., remove cropped areas, adjust resolution). 

Importance: Reduces file size, making documents easier to share and load without 

compromising quality. 

13. Explain how to use "Wrap Text" to position a picture effectively in a document. 

Steps: 

1. Select the picture. 

2. Go to the Picture Format tab. 

3. Click Wrap Text and choose an option like Tight, Square, or Behind Text. 

This ensures proper alignment with text and enhances the visual appeal of the document. 

14. List and describe three types of picture effects that can be applied to images. 

1. Shadow: Adds a shadow behind the image for depth. 

2. Reflection: Creates a mirrored effect below the picture. 

3. Glow: Adds a colored glow around the edges of the image. 

These effects enhance the visual impact of pictures. 

15. How do you create a table of contents in Microsoft Word? Mention any three benefits 

of using it. 

Steps: 

1. Use heading styles (e.g., Heading 1, Heading 2) for document titles and sections. 

2. Go to the References tab. 

3. Click Table of Contents and choose a format. 

Benefits: 

1. Improves document navigation. 

2. Provides an organized structure. 

3. Updates dynamically when headings change. 

16. Write the steps to insert footnotes and manage citations in a Word document. 

Steps to Insert Footnotes: 

1. Place the cursor where the footnote is needed. 

2. Go to the References tab. 

3. Click Insert Footnote. 

Steps to Manage Citations: 
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1. Go to the References tab. 

2. Click Insert Citation and select a source or add a new one. 

3. Use Manage Sources to edit or organize references. 

 

 Points to Remember 

• Page Layout: Adjust margins, orientation, page size, and use section breaks for 

better document structure. 

• Page Background: Enhance documents with watermarks, page colors, and borders 

for professional appeal. 

• Advanced Formatting: Use fonts, colors, borders, shading, and spacing to improve 

text presentation and readability. 

• Picture Handling: Insert and modify pictures by resizing, compressing, adjusting 

contrast, and applying styles. 

• Picture Arrangement: Position images using text wrapping, alignment, and rotation 

to fit content seamlessly. 

• References and Captions: Manage Table of contents, footnotes, citations, and 

captions to provide clear references and navigation. 

 

Self-Reflection  

1. Ask learners to re-take the self-assessment at the beginning of the unit. They should 

then fill in the table in their Trainee’s Manual to Identify their areas of strength, areas 

for improvement and actions to take to improve.  

2. Discuss trainees’ results with them. Identify any areas that are giving many trainees 

difficulties and plan to give additional support as needed (ex. use class time before you 

begin the next learning outcome to go through commonly identified difficult concepts). 
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LEARNING OUTCOME 2: APPLY BASIC COMPUTER OPERATIONS 

 

 

Learning outcome 1: Self-Assessment 

1. Ask trainees to look at the unit illustration in their Trainee’s Manuals and together discuss: 

a. What devices can you identify in the image above? 

b. What does the term "PDF" on the monitor refer to? 

c. How are these devices interconnected? 

2. After the discussion, explain to the students that this unit is designed to equip them with 

the knowledge, skills, and attitudes needed for conversion of data files, use of storage 

media, and connect computer to the network. 

3. Ask trainees to fill out the self-assessment at the beginning of the unit in their Trainee’s 

Manuals. Explain that: 

a. The purpose of the self-assessment is to become familiar with the topics in the unit 

and for them to see what they know or do not know at the beginning.  
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b. There are no right or wrong ways to answer this assessment. It is for their own 

reference and self-reflection on the knowledge, skills and attitudes acquisition during 

the learning process.  

c. They should think about themselves: do they think they have the knowledge, skills or 

attitudes to do this? How well?  

d. They read the statements across the top and put a check in column that best 

represents their level of knowledge, skills or attitudes.  

e. At the end of the unit, they will do a self-reflection, which includes re-taking the self-

assessment and identifying their strengths, areas of improvement and actions to be 

taken. 

 

Key Competencies: 

Knowledge Skills Attitudes 

1. Describe file 

conversion 

1. Identify the unity of 

storage media 

1. Pay attention to file 

compatibility during 

conversion.  

2. Identify file formats 2. Convert a file from one 

format to another 

2. Develop confidence in 

operating computers. 

3. Identify storage media  3. Use a storage media 3. Have patience when 

troubleshooting issues.  

4. Define computer 

network 

4. Format a storage 

media  

4. Provide secure network 

connections with 

proper configuration. 

5. Describe the ways to 

connect a computer to 

the internet 

5. Connect computer to 

the internet  

 

5. Have caution when 

handling sensitive data.  
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 Steps:  

Discovery Activity 

Task 11 

1. Employ suitable methods such as individual work, pair-share, small group discussions, 

guided discussions, or large group discussions to facilitate trainees in analyzing the 

picture under task 11 and sharing their understanding and prior knowledge of the 

concept "basic computer operations". Ensure that instructions are clear, all trainees are 

actively participating, and necessary materials or tools are provided and utilized 

effectively. 

 

2. Direct the trainees to Task 11 in their manual to respond to the questions. 

3. Using an appropriate methodology such as question and answer in a large group, pair 

presentations or small group presentations, trainees share their answers to the class. 

4. Encourage all trainees to share their views and findings. 

5. After the presentations or sharing session, explain to the trainees that the purpose of 

this activity was not to provide correct answers but to give them an overview of what 

will be covered in the unit. 

6. Introduce Topic 2.1: Converting of data Files. 
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Topic 2.1: Convert files into different formats 

  

Objectives:  

By the end of the topic, trainees will be able to: 

a. Describe clearly different file formats and their corresponding file extensions. 

b. Perform properly file conversions from one format to another. 

c. Explain clearly the concept of file compression and its importance 

d. Demonstrate properly the steps to compress a file. 

 
Time Required: 3 hours  

 
Learning Methodology: Group Discussion, Trainer Guided, Videos, Brainstorming, 

Demonstration, Practical Exercises, Individual Work 

 

Materials, Tools and Equipment Needed: 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

Preparation:  

❑ Prepare all necessary material and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 

Prerequisites: 

ü Prior skills in computer literacy 
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 Activity 1: Problem-Solving 

Task 12 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to help trainees analyze the 

picture of file formats and respond to the questions in Task 12 of their trainee manual. 

Ensure that the instructions are clear, all trainees are engaged, and the necessary 

materials or tools are available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 

3. After the sharing session, refer trainees to Key facts 2.1, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

Activity 2: Guided Practice 

Task 13 

1. Use a suitable approach, such as individual work, pair-share, small group discussions, 

guided discussions, or group discussions, to assist trainees to perform Task 13 in their 

trainee manuals. Ensure that instructions are clear, all trainees are actively engaged, 

and the required materials or tools are available and utilized effectively. 

2. During the task, trainees should have some independence to apply the knowledge and 

skills learned in Activity 1. Your role is to guide them by asking probing questions like 

"Why?", "What?", and "How?" to help them arrive at well-informed answers. 

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 

among others. Also attitudes and behavior changes should be handled during this 

activity. 
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4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 2.1, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that may have. 

 Activity 3: Application 

Task 14 

1. Inform the trainees that Task 14 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 14. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and perform the task 14 in order to demonstrate how to 

convert data files. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 14 with the class. 

5. The sharing or presentation session will commence once all trainees have been assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to apply 

the knowledge, skills and attitudes acquired to real life situations. Your role is to set clear 

instructions, methodology and timeframe for performing the task and presentations. 

7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment 
Criteria 

Indicator Observation  
Yes No  

1. File 
Conversion  

 

1.1. The excel spreadsheet is opened    

1.2. The file is converted from excel to PDF    

1.3. The file is saved to its appropriate 
name 

   

1.4. The conversion meet the 
requirements 
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Topic 2.2: Use of storage media 

 

 Objectives:  

By the end of the topic, trainees will be able to: 

a. Describe properly the different units of data storage 

b. Identify properly different types of storage media 

c. Format and erase data from storage media. 

 
 Time Required: 3 hours  

 
 • Learning Methodology: Group Discussion, Trainer Guided, Videos, 

Brainstorming, Demonstration, Practical Exercises, Individual Work 

 

 Materials, Tools and Equipment Needed: 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

 Preparation:  

❑ Prepare all necessary material and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

 Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 

 
Prerequisites: 

Ø Prior skills in computer literacy 
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Activity 1: Problem-Solving 

Task 15 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to help trainees analyze the 

scenario and respond to the questions in Task 15 of their trainee manual. Ensure that 

the instructions are clear, all trainees are engaged, and the necessary materials or tools 

are available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 

3. After the sharing session, refer trainees to Key facts 2.2, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

Activity 2: Guided Practice 

Task 16 

1. Use a suitable approach, such as individual work, pair-share, small group discussions, 

guided discussions, or group discussions, to assist trainees in answering the questions 

under Task 16 in their trainee manuals. Ensure that instructions are clear, all trainees 

are actively engaged, and the required materials or tools are available and utilized 

effectively. 

2. During the task, trainees should have some independence to apply the knowledge and 

skills learned in Activity 1. Your role is to guide them by asking probing questions like 

"Why?", "What?", and "How?" to help them arrive at well-informed answers. 

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 

among others. Also attitudes and behavior changes should be handled during this activity. 
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4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 2.2, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have 

 Activity 3: Application 

Task 17 

1. Inform the trainees that Task 17connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 17. 

2. Using an appropriate methodology such as individual work or pairs, trainees perform 

the task in the lab as a workplace and perform backup activities in order to demonstrate 

how to use storage media. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 4 with the class. 

5. The sharing or presentation session will commence once all trainees have been 

assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to 

apply the knowledge, skills and attitudes acquired to real life situations. Your role is to 

set clear instructions, methodology and timeframe for performing the task and 

presentations. 

7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment 
Criteria 

Indicator Observation 
Yes No 

1. Use of 
storage  

 

1.1 The capacity of storage is assessed   

1.2 The backup is done   

1.3 The storage device(s) is(are) formatted   
1.4 The recovery procedures are mentioned   
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Topic 2.3: Connection of computer to the network 

 

Objectives:  

By the end of the topic, trainees will be able to: 

a. Describe properly a computer network and its common types 

b. Compare correctly common types of networks based on size and their 

uses. 

c. Classify correctly common types of networks based on their primary 

purpose  

d. Connect a computer to both fixed and mobile internet. 

 Time Required 4 hours 

 
Learning Methodology: Group Discussion, Trainer Guided, Videos, 

Brainstorming, Demonstration, Practical Exercises, Individual Work 

 

Materials, Tools and Equipment Needed: 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

Preparation:  

❑ Prepare all necessary material and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 

Prerequisites: 

Ø Prior skills in computer literacy 
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Activity 1: Problem-Solving 

Task 18 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to help trainees analyze the 

scenario and respond to the questions in Task 18 of their trainee manual. Ensure that 

the instructions are clear, all trainees are engaged, and the necessary materials or tools 

are available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 

3. After the sharing session, refer trainees to Key facts 2.3, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

Activity 2: Guided Practice 

Task 19 

1. Use a suitable approach, such as individual work, pair-share, small group discussions, 

guided discussions, or group discussions, to assist trainees to perform Task 19 in their 

trainee manuals. Ensure that instructions are clear, all trainees are actively engaged, 

and the required materials or tools are available and utilized effectively. 

2. During the task, trainees should have some independence to apply the knowledge and 

skills learned in Activity 1. Your role is to guide them by asking probing questions like 

"Why?", "What?", and "How?" to help them arrive at well-informed answers. 

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 

among others. Also attitudes and behavior changes should be handled during this 

activity. 
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4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views. 

5. After the sharing session, refer trainees to Key facts 2.3, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have 

Activity 3: Application 

Task 20 

1. Inform the trainees that Task 20 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 20. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and create an WLAN in order to demonstrate how to a 

computer to the internet. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 20 with the class. 

5. The sharing or presentation session will commence once all trainees have been 

assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to 

apply the knowledge, skills and attitudes acquired to real life situations. Your role is to 

set clear instructions, methodology and timeframe for performing the task and 

presentations.  
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7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment 
Criteria 

Indicator Observation  

Yes No  

1. Wireless 
Local Area 
Network 
(WLAN) 

1.1 Computers for housekeeping are 
connected. 

   

1.2 The reception computer is connected.    

1.3 The administrative computer is 
connected. 

   

1.4 The internet is available.    

 

Formative Assessment  

1. Which of the following best defines a computer network? 

a. A group of connected printers 

b. A system of interconnected computers that share resources 

c. A computer without internet access 

d. A set of computer programs installed on a device 

Answer: b 

2. Which type of network is best suited for connecting devices in a small office? 

a. N 

b. LAN 

c. MAN 

d. WLAN 

Answer: b 

3. What does VPN stand for? 

a. Virtual Protected Network 

b. Virtual Private Network 

c. Verified Public Network 

d. Virtual Proxy Network 

Answer: b 

4. Which of the following is a disadvantage of computer networks? 

a. Enhanced communication 
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b. Centralized data management 

c. Vulnerability to cyberattacks 

d. Shared resources 

Answer: c 

 

5. Which type of internet connection is mobile and allows connectivity on the go? 

a. Fixed internet 

b. Satellite internet 

c. Fiber-optic internet 

d. Mobile internet 

Answer: d 

6. A LAN connects devices within a ____. 

a. City 

b. Limited area 

c. Country 

d. Multiple cities 

Answer: b) Limited area 

7. A WLAN relies on ____ to connect devices 

a. Ethernet cables 

b. Fiber-optic cables 

c. Satellites 

d. Wireless signals 

Answer: d) Wireless signals 

8. Define a computer network and describe its main features. 

Answer: 

A computer network is a system of interconnected devices, such as computers, 

printers, and servers, that share resources and communicate with each other. Main 

features include resource sharing, communication, scalability, and reliability. 

9. Compare and contrast LAN and WAN, providing an example of where each might 

be used. 

Answer: 
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a. LAN (Local Area Network): Operates within a limited area, such as a home or 

office. Example: Networking computers and printers in a small office. 

b. WAN (Wide Area Network): Covers a broad geographical area, connecting 

multiple LANs. Example: The internet or a multinational company's network. 

10. What are the key advantages and disadvantages of using a WLAN in a hotel 

setting? 

Answer: 

a. Advantages: Easy guest access, mobility, and reduced wiring costs. 

b. Disadvantages: Vulnerable to unauthorized access and slower speeds if 

overloaded. 

11. Explain the importance of VPNs for secure communication in a business 

environment. 

Answer: 

VPNs encrypt data and create secure connections over the internet, protecting 

sensitive business information from unauthorized access and ensuring privacy in 

remote communications. 

12. Describe the process of connecting a computer to the internet using both fixed and 

mobile internet. 

Answer: 

a. Fixed Internet: Connect the computer to a router using an Ethernet cable or Wi-

Fi. 

b. Mobile Internet: Use a mobile hotspot or tethering feature from a smartphone 

to provide connectivity. 

13. Set up a basic WLAN on your laptop or mobile device, and test its ability to connect 

multiple devices simultaneously. 

Answer: 

a. Enable the hotspot feature or create a wireless network on the laptop/mobile 

device. 

b. Connect other devices by entering the network name and password. 

c. Test simultaneous connections by accessing the internet or sharing files. 
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14. Create a diagram showing the connections between devices in a LAN for a small 

office with three computers and a shared printer. 

 

Answer: 

 

 Points to Remember 

• Common file formats and their extensions, along with tools for converting files 

(e.g., files to PDF, PDF to Word/Excel/PPT). 

• File compression (saving storage space) and the steps to compress files 

effectively. 

• Types of storage media (offline vs. online), storage capacities (bytes, KB, MB, etc.) 

• The types of networks based on size are PAN, LAN, WAN. 

• The types of networks based on usage are SAN (data storage), EPN (private 

enterprise use), and VPN (secure remote access). 

• Two types of internets are broadband and mobile internet options for connecting 

devices efficiently. 
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Self-Reflection  

1. Ask learners to re-take the self-assessment at the beginning of the unit. They should then 

fill in the table in their Trainee’s Manual to Identify their areas of strength, areas for 

improvement and actions to take to improve.  

2. Discuss trainees’ results with them. Identify any areas that are giving many trainees 

difficulties and plan to give additional support as needed (ex. use class time before you 

begin the next learning outcome to go through commonly identified difficult concepts). 
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LEARNING OUTCOME 3: MANAGE DATA IN MS EXCEL 

 

 

Learning outcome 1: Self-Assessment 

1. Ask trainees to look at the unit illustration in their Trainee’s Manuals and together discuss: 

a. What do you see on the above illustration?  

b. What do you think is the purpose of the highlighted tools like sorting, filtering, and 

chart creation in Excel?  

c. How might these help in managing data? 

2. After the discussion, explain to the students that this unit is designed to equip them with 

the knowledge, skills, and attitudes needed to manage data types in MS Excel, apply Excel 



 

41 | INFORMATION AND COMMUNICATION TECHNOLOGY (ICT) – TRAINER’S MANUAL 
 

functions, perform data analysis and visualization, and application of data protection 

techniques. 

3. Ask trainees to fill out the self-assessment at the beginning of the unit in their Trainee’s 

Manuals. Explain that: 

a. The purpose of the self-assessment is to become familiar with the topics in the unit 

and for them to see what they know or do not know at the beginning.  

b. There are no right or wrong ways to answer this assessment. It is for their own 

reference and self-reflection on the knowledge, skills and attitudes acquisition during 

the learning process.  

c. They should think about themselves: do they think they have the knowledge, skills or 

attitudes to do this? How well?  

d. They read the statements across the top and put a check in column that best 

represents their level of knowledge, skills or attitudes.  

e. At the end of the unit, they will do a self-reflection, which includes re-taking the self-

assessment and identifying their strengths, areas of improvement and actions to be 

taken. 

 

Key Competencies: 

Knowledge Skills Attitudes 

1. Explain the types of 
data in excel. 

1. Sort data 1. Pay attention to 
appropriate data type 
usage.  

2. Describe data 
protection principles 

2. Remove duplicates in 
dataset 

2. Have consistency in 
formatting and 
formulas. 

3. Identify Excel 
functions 

3.  Perform data validation 3. Pay attention to data 
accuracy.  

4. Describe the ways to 
protect data in excel 

4. Apply Excel functions 4. Be analytical when 
interpreting results  

5. Identify data 
validation techniques 

5. Check errors in data 5. Provide clear 
visualizations using 
charts and tables 
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Knowledge Skills Attitudes 

 6. Manage large dataset  

 7. Apply data protection 
principles. 

 

 8. Implement data 
visualization 

 

 

 Steps:  

Discovery Activity 

Task 21 

1. Employ suitable methods such as individual work, pair-share, small group discussions, 

guided discussions, or large group discussions to facilitate trainees in analyzing the 

picture under task 21 and sharing their understanding and prior knowledge of the 

concept "Management of data in MS Excel." Ensure that instructions are clear, all 

trainees are actively participating, and necessary materials or tools are provided and 

utilized effectively. 

2. Direct the trainees to Task 21 in their manual to respond to the questions. 

3. Using an appropriate methodology such as question and answer in a large group, pair 

presentations or small group presentations, trainees share their answers to the class. 

4. Encourage all trainees to share their views and findings. 

5. After the presentations or sharing session, explain to the trainees that the purpose of 

this activity was not to provide correct answers but to give them an overview of what 

will be covered in the unit. 

6. Introduce Topic 3.1: Management of data types in MS Excel 
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Topic 3.1: Management of data types in MS Excel 

  

Objectives:  

By the end of the topic, trainees will be able to: 

a. Describe different data types and their default formats when entered into cells. 

b. Implement properly data validation rules to ensure accuracy and consistency in 

data entry. 

c. Create appropriate data validation rules in MS Excel 

 
Time Required: 2 hours  

 
Learning Methodology: Group Discussion, Trainer Guided, Videos, Brainstorming, 

Demonstration, Practical Exercises, Individual Work 

 

Materials, Tools and Equipment Needed: 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

Preparation:  

❑ Prepare all necessary material and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 

Prerequisites: 

ü Prior skills in computer literacy 
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 Activity 1: Problem-Solving 

Task 22 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to help trainees analyze 

the scenario and respond to the questions in Task 22 of their trainee manual. Ensure 

that the instructions are clear, all trainees are engaged, and the necessary materials 

or tools are available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers 

with the class. Record their responses for reference and encourage everyone to 

contribute their views. 

3. After the sharing session, refer trainees to Key facts 3.1, and discuss them together 

while harmonizing their responses provided in the sharing session and answer any 

questions that they may have. 

 

Activity 2: Guided Practice 

Task 23 

1. Use a suitable approach, such as individual work, pair-share, small group discussions, 

guided discussions, or group discussions, to assist trainees to perform Task 23 in their 

trainee manuals. Ensure that instructions are clear, all trainees are actively engaged, 

and the required materials or tools are available and utilized effectively. 

2. During the task, trainees should have some independence to apply the knowledge and 

skills learned in Activity 1. Your role is to guide them by asking probing questions like 

"Why?", "What?", and "How?" to help them arrive at well-informed answers. 

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 
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among others. Also attitudes and behavior changes should be handled during this 

activity. 

4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 3.1, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 Activity 3: Application 

Task 24 

1. Inform the trainees that Task 24 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 24. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and perform data manipulations in order to demonstrate 

how to manage data in MS Excel. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 24 with the class. 

5. The sharing or presentation session will commence once all trainees have been assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to apply 

the knowledge, skills and attitudes acquired to real life situations. Your role is to set clear 

instructions, methodology and timeframe for performing the task and presentations. 
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8. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

 

Assessment Criteria Indicator Observation  

Yes No  

1. Data 

Management 

 

1.1. The table is sorted by room type in 

alphabetical order 

   

1.2 The billing amount is sorted from the 

highest to lowest. 

   

1.3 Sorting steps are indicated    

1.4 Remove duplicate entries for John Doe in 

the table 

   

1.5 Validation (for specific rooms) is created    

1.6 Steps for restricting entries to room types 

are shown 
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Topic 3.2: Application of Excel functions 

 

 Objectives:  

By the end of the topic, trainees will be able to: 

a. Apply properly basic functions in a spreadsheet, including SUM, 

AVERAGE, MAX, MIN, COUNT, and RANK, to perform calculations and 

analyze data. 

b. Correct properly errors in spreadsheet data using built-in error-checking 

tools, ensuring data integrity and reliability. 

c. Apply correctly the IF function to build logical statements and solve 

conditional problems in spreadsheets. 

 
 Time Required: 3 hours  

 
 • Learning Methodology: Group Discussion, Trainer Guided, Videos, 

Brainstorming, Demonstration, Practical Exercises, Individual Work 

 

 Materials, Tools and Equipment Needed: 

 • Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

 Preparation:  

❑ Prepare all necessary material and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

 Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging 

balanced participation from all genders 

 

 
Prerequisites: 

Ø Prior skills in computer literacy 
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Activity 1: Problem-Solving 

Task 25 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to help trainees analyze the 

scenario and respond to the questions in Task 25 of their trainee manual. Ensure that 

the instructions are clear, all trainees are engaged, and the necessary materials or tools 

are available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 

3. After the sharing session, refer trainees to Key facts 3.2, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

Activity 2: Guided Practice 

Task 26 

1. Using an appropriate methodology such as individual work, pair-share, small group 

discussions, guided discussions or large group discussion, guide trainees to perform the 

task provided under task 26 in their trainee manuals. Make sure instructions are 

understood, all the trainees are actively participating, and necessary materials/tools are 

provided and being used. 

2. During the task, trainees should be given degree of independence to apply the 

knowledge and skills acquired in activity 1. Your role is to guide them by using probing 

questions such as Why? What? How? to enable them to come to informed responses.  

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 
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among others. Also attitudes and behavior changes should be handled during this 

activity. 

4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 3.2, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

 Activity 3: Application 

Task 27 

1. Inform the trainees that Task 27 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 27. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and perform calculations in order to demonstrate how to 

use MS Excel functions. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 27 with the class. 

5. The sharing or presentation session will commence once all trainees have been 

assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to 

apply the knowledge, skills and attitudes acquired to real life situations. Your role is to 

set clear instructions, methodology and timeframe for performing the task and 

presentations. 
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7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment 

Criteria 

Indicator Observation  

Yes No  

1. Apply Excel 

basic 

functions 

 

1.1 Total revenue generated from room 

rates using the SUM function 

   

1.2 Average room rate using the AVERAGE 

function is founded. 

   

1.3 The max and min is founded to room 

rates 

   

1.4 Count of number of bookings using 

count function 

   

1.5 Rank is founded using rank function    

1.6 Reference in a cell is mentioned    

1.7 The room are classified with the 

highest revenue 

   

 

Topic 3.3: Perform data analysis and visualization in excel 

 

Objectives:  

By the end of the topic, trainees will be able to: 

a. Create and customize properly various types of charts to effectively visualize 

data. 

b. Apply properly table styles using conditional formatting to highlight key 

insights. 

c. Apply correctly cell styles to improve the appearance and readability of data 

in a spreadsheet. 

 
Time Required 2 hours. 

 
• Learning Methodology: Group Discussion, Trainer Guided, Videos, 

Brainstorming, Demonstration, Practical Exercises, Individual Work 
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Materials, Tools and Equipment Needed: 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

Preparation:  

❑ Prepare all necessary material and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 

Prerequisites: 

Ø Prior skills in computer literacy 

 

Activity 1: Problem-Solving 

Task 28 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to guide trainees analyze the 

scenario and respond to the questions in Task 28 of their trainee manual. Ensure that 

the instructions are clear, all trainees are engaged, and the necessary materials or tools 

are available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 
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3. After the sharing session, refer trainees to Key facts 3.3, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

Activity 2: Guided Practice 

Task 29 

1. Use a suitable approach, such as individual work, pair-share, small group discussions, 

guided discussions, or group discussions, to assist trainees to perform Task 29 in their 

trainee manuals. Ensure that instructions are clear, all trainees are actively engaged, 

and the required materials or tools are available and utilized effectively. 

2. During the task, trainees should have some independence to apply the knowledge and 

skills learned in Activity 1. Your role is to guide them by asking probing questions like 

"Why?", "What?", and "How?" to help them arrive at well-informed answers. 

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 

among others. Also attitudes and behavior changes should be handled during this 

activity. 

4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 3.3, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 
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Activity 3: Application 

Task 30 

1. Inform the trainees that Task 30 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 30. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and design charts in MS Excel in order to demonstrate 

Data analysis and visualization. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 30 with the class. 

5. The sharing or presentation session will commence once all trainees have been 

assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to 

apply the knowledge, skills and attitudes acquired to real life situations. Your role is to 

set clear instructions, methodology and timeframe for performing the task and 

presentations. 

7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment 
Criteria 

Indicator Observation  
Yes No  

1. Data 
visualisation  

1.1 The chart is created for each room 
type 

   

1.2 The data in table are formatted    

1.3 Cell styles is done on headers    

1.4 Conditional formatting is used to 
highlight the highest and lowest 
room rates 
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 Topic 3.4: Application of data protection techniques in excel 

 

Objectives:  

By the end of the topic, trainees will be able to: 

a. Describe properly key data protection principles and their importance in 

safeguarding sensitive information in Excel files. 

b. Protect correctly specific cells and worksheets in Excel to prevent 

unauthorized editing or accidental changes. 

c. Apply properly workbook-level protection methods to restrict access and 

enhance the overall security of Excel data. 

 
Time Required 3 hours. 

 
Learning Methodology: Group Discussion, Trainer Guided, Videos, Brainstorming, 

Demonstration, Practical Exercises, Individual Work 

 

Materials, Tools and Equipment Needed: 

• Whiteboard, Blackboard, Projector, Computers, software, Internet 

• Markers, flipchart, chalk, Pens, Trainee and Trainer manuals 

 

Preparation:  

❑ Prepare all necessary material and tools required for the topic delivery 

❑ Prepare computer laboratories to be ready for use 

' 

Cross Cutting Issues: 

ü Ensure gender balance while forming groups, allocating tasks and during 

presentations. 

ü Take into consideration learners with special needs while assigning tasks 

ü Ensure safety measures for handling tools and equipment. 

ü Promote gender equality by challenging stereotypes, encouraging balanced 

participation from all genders 

 

Prerequisites: 

Ø Prior skills in computer literacy 
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Activity 1: Problem-Solving 

Task 31 

1. Utilize an appropriate methodology, such as individual work, pair-share, small group 

discussions, guided discussions, or large group discussions, to guide trainees analyze the 

scenario and respond to the questions in Task 31 of their trainee manual. Ensure that 

the instructions are clear, all trainees are engaged, and the necessary materials or tools 

are available and being used. 

2. Using an appropriate approach, such as question-and-answer in a large group, pair 

presentations, or small group presentations, have the trainees share their answers with 

the class. Record their responses for reference and encourage everyone to contribute 

their views. 

3. After the sharing session, refer trainees to Key facts 3.4, and discuss them together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

 

Activity 2: Guided Practice 

Task 32 

1. Using an appropriate methodology such as individual work, pair-share, small group 

discussions, guided discussions or large group discussion, guide trainees to perform the 

task provided under task 32 in their trainee manuals. Make sure instructions are 

understood, all the trainees are actively participating, and necessary materials/tools are 

provided and being used. 

2. During the task, trainees should be given degree of independence to apply the 

knowledge and skills acquired in activity 1. Your role is to guide them by using probing 

questions such as Why? What? How? to enable them to come to informed responses.  

3. While trainees are still performing the task, use this opportunity to discuss or address 

any cross-cutting issues that may arise such as gender, inclusivity, financial education 



 

56 | INFORMATION AND COMMUNICATION TECHNOLOGY (ICT) – TRAINER’S MANUAL 
 

among others. Also attitudes and behavior changes should be handled during this 

activity. 

4. Using an appropriate methodology such as question and answer in a large group, pair 

presentations, or small group presentations, trainees share their answers to the class. 

Write their responses for reference. Encourage all trainees to give their views.  

5. After the sharing session, refer trainees to Key facts 3.4, and discuss together while 

harmonizing their responses provided in the sharing session and answer any questions 

that they may have. 

 

Activity 3: Application 

Task 33 

1. Inform the trainees that Task 33 connects them to the professional world. Instruct them 

to go to the school’s computer lab and complete Task 33. 

2. Using an appropriate methodology such as individual work or pairs trainees perform the 

task in the lab as a workplace and protect workbook in order to demonstrate how to 

protect data in MS Excel. 

3. Provide additional guidance or instructions on their tasks, connecting what they have 

learned in the classroom to the activities they will perform in the workplace. 

4. Inform the trainees that everyone will be assessed individually and later share the 

experiences they gained from task 33 with the class. 

5. The sharing or presentation session will commence once all trainees have been 

assessed. 

6. This activity requires trainees to work independently with limited support from the 

trainer. During the task, trainees should be given a high degree of independence to 

apply the knowledge, skills and attitudes acquired to real life situations. Your role is to 

set clear instructions, methodology and timeframe for performing the task and 

presentations.  
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7. Use the following Checklist for Assessing Trainees’ Understanding but not limited to. 

Assessment 

Criteria 

Indicator Observation  

Yes No  

1. Data analysis  1.1 The table is retyped    

1.2 The data is accurate    

1.3 The workbook is protected    

 Formative Assessment  

1. Which of the following is the default format for a cell when data is entered in 

Excel? 

a. Text 

b. General 

c. Number 

d. Currency 

Answer: b) General 

2. Which Excel function is used to find the largest value in a range of cells? 

a. SUM 
b. MAX 
c. COUNT 
d. AVERAGE 
Answer: b) MAX 

3. What is the purpose of using data validation rules in Excel? 

a. To format the data automatically 

b. To prevent incorrect data entry 

c. To sort the data in ascending order 

d. To find and replace data 

Answer: b) To prevent incorrect data entry 

4. What type of data format is typically used for displaying monetary values in Excel? 

a. Currency 

b. Date 

c. Number 

d. Text 
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Answer: a) Currency 

5. How can you protect an entire workbook in Excel? 

a. By locking specific cells 
b. By encrypting it with a password 
c. By using conditional formatting 
d. By formatting as a table 
Answer: b) By encrypting it with a password 

6. Which function would you use to calculate the total sum of a range of numbers in 

Excel? 

a. AVERAGE 

b. COUNT 

c. SUM 

d. MIN 

Answer: c) SUM 

7. Explain how data types in Excel can affect how you enter and format data in cells. 

Provide examples of different data types and their default formats. 

a. Text: Default format aligns text to the left. Example: "Hello". 

b. Number: Default format aligns numbers to the right without commas or 

decimals. Example: 123. 

c. Date: Automatically converts valid date entries into a specific date format. 

Example: "12/25/2024". 

d. Currency: Displays numbers with a currency symbol and two decimal places. 

Example: "$123.45". 

Proper data type usage ensures correct calculations and data presentation. 

8. Describe the process of protecting a worksheet in Excel. What are the steps to lock 

cells, and how does this help in preventing unauthorized changes to sensitive data? 

To protect a worksheet: 

a. Step 1: Select the cells you want to keep editable (optional) and go to Format 

Cells > Protection > Uncheck "Locked". 

b. Step 2: Go to the Review tab and click Protect Sheet. 

c. Step 3: Set a password (optional) and choose permissions for users. 

This prevents unauthorized changes by restricting editing to specific cells or areas 

while protecting sensitive data. 
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9. How do you create a chart in Excel, and why is it important to use charts for 

visualizing data? Provide an example of a situation where using a chart would be 

beneficial. 

To create a chart in Excel: 

a. Select the data range. 

b. Go to the Insert tab and choose a chart type (e.g., Bar, Line, Pie). 

c. Customize the chart with titles, labels, and colors as needed. 

Importance of charts: 

Charts simplify complex data, making trends and comparisons easier to understand. 

Example: 

A sales manager can use a bar chart to compare monthly sales across different 

regions, helping identify high- and low-performing areas quickly. 

 

 Points to Remember 

• Data protection principles ensure confidentiality, integrity, availability, and 

accountability of sensitive data. 

• Protect a cell by locking specific cells to prevent unauthorized changes to sensitive 

data. 

• Protect a worksheet to prevent modifications to the structure or content by 

unauthorized users. 

• Protect a workbook by applying a password to restrict access and prevent 

unauthorized changes to the entire file. 

• These protections maintain data security, ensuring only authorized users can 

access or modify sensitive information. 
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Self-Reflection  

1. Ask learners to re-take the self-assessment at the beginning of the unit. They should 

then fill in the table in their Trainee’s Manual to Identify their areas of strength, areas 

for improvement and actions to take to improve.  

2. Discuss trainees’ results with them. Identify any areas that are giving many trainees 

difficulties and plan to give additional support as needed (ex. use class time before 

you begin the next learning outcome to go through commonly identified difficult 

concepts) 
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